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Chapter 1: Tools and Their Uses

This chapter will help you become familiar with Photoshop's 

basic and advanced tools, their locations, and their uses. When 

you open Photoshop, click windows at the top of the screen and 

drag down to tools and click. This will give you access to your 

basic set of tools. The tool bar will open up on the left side in a 

single column. Clicking on the double arrows at the top of the 

tools bar will bring the tool bar to a double column format. Not all 

of your tools will show up here. To access the hidden tools go to 

the top of your screen and select edit, then preferences, then 

general. You also can easily go to the tool you want to use, right 

click on it and press the letter that corresponds to the tool you 

want. Whenever you place your mouse over the icon of a tool, it will give 

you the name or keyboard shortcut. If you would like to turn this off, go to 

the preferences screen again. Then in the interface section you will be able 

to turn it off. 
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Now we will break down Photoshop's tools and their uses. Use this as a 

reference until you are familiar with all of the tools and the different things 

you can do with them.  The options in Photoshop are almost limitless, and 

these tiny tools bring your visions to life.

Move Tool

This tool does exactly what its name implies; it moves things. Moving layers 

is the most common use for this tool. Holding down the shift key will limit 

movement to only horizontal or vertical. The quick key for the move tool is 

the letter V.

Rectangular Marquee Tool

You use this tool to make a rectangular selection on the image you are 

working on. Using this tool will limit the effects of other tools and actions to 

the selected part. To create a perfect square hold down the shift key and drag 
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your selection. To set the center of your rectangle to the spot where your 

mouse began, hold down the alt key. After your selection is set, if you need 

to move it press the space bar.

Elliptical Marquee Tool

To find this tool click and hold down the mouse and a pop-up window will 

appear. Here you will be able to select the elliptical marquee tool. The 

elliptical marquee tool gives you an elliptical selection shape instead of a 

rectangular one. To make a perfect circle with the elliptical marquee just 

hold down the shift key. To set the center of your elliptical shape to the spot 

where your mouse began, hold down the alt key. After your selection is set, 

if you need to move it press the space bar and move it to where you want it. 
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Single Row and Column Marquee Tools

To find this tool, click and hold down the mouse and a pop-up window will 

appear. Here you will be able to select the elliptical marquee tool. The single 

row marquee tool lets you select an entire row of pixels while the single 

column marquee tool lets you select an entire column of pixels. 

Lasso Tool

The lasso tool gives you the freedom to make a selection in any shape you 

want. Just click your mouse and make the shape you desire. To close your 

selection, either click the start point or double-click and it will go away. 

Pressing the L button will automatically select this tool. 

Polygonal Lasso Tool

With the polygonal lasso tool, you can create selections with a series of 

straight edges. Instead of holding down your mouse like with the lasso tool, 
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you click on various points to make your selections. Pressing shift + L will 

toggle your lasso tools. Press L repeatedly to scroll through lasso tools until 

this tool is selected.

Magnetic Lasso Tool

For areas in your image that have very defined edges, the magnetic lasso 

tool is what you want to use. Click at the starting point of your selection and 

drag along the edges of your selection. Fastening points are automatically 

made, but can be made manually by just clicking where you want it. 

Pressing shift + L will toggle your lasso tools. Press L repeatedly to scroll 

through lasso tools until this tool is selected.

Magic Wand Tool

You will use this tool when you are selecting a color range. Depending upon 

where you click, it will select a section of color, or transparency. To make 

your selections more precise, go to the top and select the option bar and 
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change the tolerance. To select this tool without using your mouse, press the 

W key. 

Quick Select Tool

When you want to make selections faster, the quick select tool is here to 

help. This tool allows you to make selections with brush options. The quick 

selection tool uses a rounded brush tip to paint a selection. While you are 

dragging, the selection will expand outward and find defined edges 

automatically.  Select this tool without using your mouse by pressing shift + 

W. 

Crop Tool

Using the crop tool gives you the ability to select a specific section you want 

in an image. Use the crop tool and open the box over the area of the image 

that you want to keep. By either pressing enter or double-clicking, it will 

remove the rest of the image except for the part you have selected. If you do 

not like the part you have cropped, just simply go to edit at the top of your 
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screen and choose undo, or press ctrl + Z.  Select this tool without using 

your mouse by pressing the C key.

Slice Tool

The slice tool splits an image into smaller sections with straight edges that 

go together similar to a jigsaw puzzle. This tool is used more when it comes 

to web design. To use the slice tool, click and drag over the area you want to 

make a slice on. Photoshop will automatically make the number of slices 

necessary once you release the mouse button. Your active slice will remain 

highlighted. Select this tool without using your mouse by pressing the K 

key. 

Slice Select Tool

The slice select tool is just the next step once you slice an image. This tool 

allows you to select and modify your slices that exist. To select this tool 

without using your mouse press shift + K
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Healing Brush Tool

This tool repairs any imperfections that you may have on your image.  Select 

this tool without using your mouse by pressing the J key.

Spot Healing Brush Tool

This tool will take any small, unwanted blemishes from an image and clean 

them up a little easier than the healing brush tool. This tool will take pixels 

from around the area you are cleaning and make its own sample to match the 

lighting, tone, and texture. Select this tool without using your mouse by 

pressing shift + J.

Patch Tool

The patch tool fixes areas that need repair with pixels from other areas of the 

image. The patch tool acts just like the healing brush: matching the shading, 

texture, and lighting of sampled pixels for the area you first selected. Also, 
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you can clone isolated spots in the image. Select this tool without using your 

mouse by pressing shift + J.

Red Eye Tool

Those hated red eyes you get from the flash of your camera. Photoshop 

gives you a better result when fixing the red eye. Select this tool without 

using your mouse by pressing shift + J.

Brush Tool

This is the most familiar tool of them all. It takes the color that you have 

selected and paints it on your image. Select this tool without using your 

mouse by pressing the B key.

Pencil Tool

The pencil acts just like the paint brush, but instead it uses hard edges. Select 

this tool without using your mouse by pressing shift + B. 
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Color Replacement Tool

This tool will allow you to replace a color without losing any detail in your 

image. Once you finish something and you like the design, just not the color, 

you can use this tool to make that change. Select this tool without using your 

mouse by pressing shift + B. 

Clone Stamp Tool

This tool does the same job as the healing brush tool, but leaves out the 

blending. It takes the information from the first area and places it on the 

second. To select this tool without using your mouse press the letter S.

Pattern Stamp Tool

The pattern stamp tool allows you to paint with a pattern from the Photoshop 

library, or an original pattern that you created. Select this tool without using 

your mouse by pressing shift + S. 
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History Brush Tool

Your history brush tool paints with the original information of your image. 

Clicking on windows then history and it will show you which history state it 

will be painting from. Select this tool without using your mouse by pressing 

the letter Y.

Art History Brush Tool

This tool lets you paint stylized strokes from sources of data from a snapshot 

or history state. The art history brush tool lets you paint like the history 

brush except you get to change the options to create your own look. Select 

this tool without using your mouse by pressing shift + S.

Eraser Tool

This tool is simple. Once you create something and you do not like it, click 

the eraser tool and erase it. If you are using layers, it will erase whatever is 
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on the layer you have selected. Select this tool without using your mouse by 

pressing the letter E.

Background Eraser Tool

This eraser uses the color from the brush and removes it and the soft edges 

from your image. By doing this, the main image you want can be copied and 

the background color will not show up. To select this tool without using 

your mouse by pressing shift + E.

Magic Eraser Tool

This tool removes all the pixels that fit in the tolerance range you set. This 

tool is best used for backgrounds with a solid color. Select this tool without 

using your mouse by pressing shift + E. 
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Gradient Tool

Takes your foreground color and your background color and blends them 

together. Click and drag the tool to create a gradient image. Select this tool 

without using your mouse by pressing the letter G.

Paint Bucket Tool

Also called a Flood Fill Tool, this tool simply fills in the areas where you 

click with the foreground color. Once you switch to this your mouse will 

turn into a paint bucket. Select this tool without using your mouse by 

pressing shift + G.

Blur Tool

This tool makes your image blurry. By clicking and dragging on an image it 

makes the area you are working have a blurred effect. Then more dragging 
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you do, the blurrier the area becomes. Select this tool without using your 

mouse by pressing the letter R.

Sharpen Tool

The sharpen tool does the opposite of the blur tool. The sharpen tool 

sharpens an image by sharpening the edges in portions. Select this tool 

without using your mouse by pressing shift + R.

Smudge Tool

This tool does is similar to the blur tool. The smudge tool blends the colors 

together. Select this tool without using your mouse by pressing shift + R.
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Dodge Tool

This tool lightens areas you select. If the area is black, the dodge tool is of 

no use and will not lighten. Select this tool without using your mouse by 

pressing the O key.

Burn Tool

The burn tool does the opposite of the dodge tool. The burn tool darkens an 

area on your image. Select this tool without using your mouse by pressing 

shift + O.

Sponge Tool

This tool changes the level of saturation of colors on the area you selected. 

Select this tool without using your mouse by pressing shift + O.
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Pen Tool

This tool creates your paths. Paths can be used to create selections or 

clipping paths. You also make straight lines and smooth vector shapes. 

Select this tool without using your mouse by pressing the letter P.

Freeform Pen Tool

This tool gives you freedom to draw while anchor points are placed 

automatically. After you are done drawing you can adjust where the anchor 

points are placed. Select this tool without using your mouse by pressing shift 

+ P.

Add and Delete Anchor Point Tool 

When you add anchor points you have more control over your path. Deleting 

unnecessary points will reduce the complexity of the paths that you have 

created. Select this tool without using your mouse by pressing shift + P.
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Convert Point Tool

This tool allows you to edit vector shape masks and paths that already exist. 

It converts corner anchor points to smooth anchor points and vice versa. 

Select this tool without using your mouse by pressing shift + P.

Horizontal Type Tool

This tool places vector-based text horizontally in a new layer. Select this tool 

without using your mouse by pressing the T key.

Vertical Type Tool

This tool makes in a new layer, vector-based text vertically. Select this tool 

without using your mouse by pressing shift + T.
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Horizontal Type Mask Tool

This tool makes selections of type-shapes horizontally. Select this tool 

without using your mouse by pressing shift + T.

Vertical Type Mask Tool

This tool makes selections of type-shapes vertically. Select this tool without 

using your mouse by pressing shift + T.

Path Selection Tool

When working with paths, this is the tool you will use. The path selection 

tool selects and moves pieces of anchor points, existing paths, and vector 

shape mask segments. Select this tool without using your mouse by pressing 

the A key.
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Direct Selection Tool

This tool selects and moves whole existing paths, anchor points, and vector 

shape mask segments. Select this tool without using your mouse by pressing 

shift + A.

Rectangle Tool

This tool makes rectangle shapes and paths, and fills with the foreground 

color you have selected. Select this tool without using your mouse by 

pressing the letter U.

Rounded Rectangle Tool

This tool makes rectangle shapes and paths with rounded corners, and fills 

with the foreground color. Select this tool without using your mouse by 

pressing shift + U.
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Ellipse Tool

This tool makes ellipse shapes which are filled with your foreground color. 

Select this tool without using your mouse by pressing shift + U.

Polygon Tool

This tool makes polygonal shapes and paths which are filled with your 

foreground color. Select this tool without using your mouse by pressing shift 

+ U.

Line Tool

This tool makes line shapes and paths. Select this tool without using your 

mouse by pressing shift + U.
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Custom Shape Tool

This tool lets you create custom shapes and paths that will be filled with 

your foreground color. Select this tool without using your mouse by pressing 

shift + U.

Notes Tool

This tool allows you to attach notes to your image. Select this tool without 

using your mouse by pressing the letter N.

Audio Annotation Tool

This tool allows you to attach voice notes to your images. Select this tool 

without using your mouse by pressing shift + N.

Eyedropper Tool
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This tool takes the background and foreground and makes them both more 

defined. Select this tool without using your mouse by pressing the letter I.

Color Sampler Tool

This tool gives you the chance to see the values of the colors in defined 

spots. Select this tool without using your mouse by pressing shift + N.

Ruler Tool

This tool takes the angles and distances and calculates them in your work 

area. Select this tool without using your mouse by pressing shift + N.

Count Tool
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This tool counts the number of objects you may have in your image. You 

can do this manually by just clicking on the objects and Photoshop will keep 

up with the number of clicks you make. Select this tool without using your 

mouse by pressing shift + N. 

Hand Tool

The hand tool can move your whole image inside the window you are 

working in. This tool is best used when you are zoomed in and want to see 

another part of the image, you can use the hand tool to move over to that 

spot. Select this tool without using your mouse by pressing the H key. 

Zoom Tool

This tool allows you to see your image more closely. Holding the alt key 

zooms back out. If you have multiple windows open, hold the shift key 

while clicking your zoom button and all your windows will zoom in. To 
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return back to 100% just double-click the zoom button in the tool palette. 

Select this tool without using your mouse by pressing V.

Foreground and Background

The box in front is your foreground and the one in the back is your 

background. The two small boxes are your default colors, which are black 

and white. 
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Chapter 2: Headers in Photoshop

In this chapter, we will discuss designing web headers in Photoshop.  A 

header is important because it increases the visual appeal of your website.  

When you arrive on a website your eyes automatically look for the header, 

focusing on the top center of the page.  As consumers, we expect to see 

information here that will help us navigate or better understand the content 

of the page.  Some websites utilize navigational headers to make it easier for 

visitors to find the information they seek.  Other websites use a graphic 

header to entice users and foster a feeling from the website.  For instance, if 

the site is geared toward children, the header would likely contain cartoon 

images, ice cream, toys, or some other item that would appeal to children.  

This often gives visitors a sense of excitement and an urge to take a closer 

look at the content on the page.

The first step to creating a header is deciding what kind of header your site 

needs.  Your target audience should be given great consideration.  Making 
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the website attractive and inviting for your target audience is the most 

important aspect of a header.

The header performs two basic functions on your website. It gives the 

viewer of it a quick overview of what your website is about, and it also 

provides an idea of the quality of your site.

Each of these functions is of great importance, but the second may be even 

more important than the first. There are millions of websites out there and 

possibly hundreds or thousands compete with yours. If the style or make-up 

of your header gives your website the look that it lacks quality or 

professionalism, your traffic will go to your competitors instead.
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Now that you understand the importance of a good header we will set about 

designing one in Photoshop.  Sizing your header is important.  You do not 

want to take up too much room above the fold, so the height of the header 

should ideally be no more than 200 pixels or so.  A good width for your 

header would be 800 pixels, because this is the standard viewing width of 

many computers.
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Having chosen your width and height, you are ready to start creating your 

header.   The following instructions will give you a base to start from.  

Possibilities are endless and as you already know, Photoshop will help you 

create anything you set your mind to.  Remember that these steps are just 

building blocks; simply showing you how to make a header.  You may add 

to or take away from these steps in order to make your own unique header.  

Follow these simple instructions to get you started making your own high 

quality header:
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Creating a Header

 Create an image with your dimensions.  For this example, we will use 

a width of 800 pixels and a height of 200 pixels.

 Choose your foreground and background colors.  For this example, we 

will use pink and black respectively.

 Create a new layer.

 Using the paint bucket, fill the whole area with any color.  For this 

example, we are using our foreground color, pink.
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 Go to Layer > Layer Style > Gradient Overlay.

 Change layer properties to gradient overlay with 100% opacity.

 Create a new layer.

 Select the upper half of the whole area with the rectangle marquee 

tool.
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 Using the paint bucket tool, fill the selected area with white. 

 Go to Layer > Layer Style > Overlay.

 Set the opacity to 5%.

 Create a new layer.

 Fill the whole area with white. 



~ 36 ~

 In the layers palette, set the layer to Overlay, 100% opacity.

 Go to Layer > Layer Style > Inner Glow.

 Set the opacity to 75%.

 Go to Layer > Layer Style > Color Overlay.

 Set to 70% opacity and choose a color. For this example, we are using 

purple.
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 Go to Layer > Layer Style > Satin.

 Set the opacity to 50%.

 Set the angle to -20.

 Set the distance to 6 pixels.

 Set the size to 14 pixels.

 Choose a contour.
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 Create a new layer.

 Add text using the text tool your website title.

These steps helped you get a good idea of what can be done with a header.  

When creating a header, remember that it is a representation of your website 

at a glance.  Your visitors will often judge your website and the content 

therein based solely on your header.  If your header is exciting and 
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informational, your visitors are likely to stay on your site and delve deeper 

into your content, rather than leaving your site to find another source.  

Happy header making!
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Chapter 3: Web Design Using Slices

When you slice an image, the slice divides an image into smaller images that 

are shown on a web page using CSS layers, or html table. When you divide 

the image, you can assign different URL links to create page navigation, or 

your optimization settings are used to optimize each section of image. You 

export and optimize a sliced image using the save for web & devices option. 

Photoshop generates the html code or CSS code that you need to show you 

sliced image by saving each slice as a separate file.

When you work with slices, keep these basics in mind, you can either create 

a slice by using the slice tool or you can create them using layer-based 

slices. After you create a slice, you can select it using the slice select tool 

and then resize, align, or move it to other slices. You can set your options for 

each slice, which include the type, name, and URL in the slice options box. 

In your save for web and devices is where you find the options for different 

settings to optimize each slice. 
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Slice Types

Slices are categorized by their content type, which included auto, image, or 

no-image, and are categorized by the way they are created, user, layer-based, 

or auto. When you create slices with the slice tool, they are called user 

slices. When you create slices from a layer they are called layer-based slices. 

Once you create a new user slice or layer-based slice, extra auto slices are 

made to fill in for the remaining areas of the image. You could also say that 

auto slices fill the space in the image that is not defined by user slices or 

layer-based slices. Auto slices are remade every time you add or edit user 

slices or layer-based slices, and you can easily convert auto slices to user 

slices.

User slices, layer-based slices, and auto slices differ in their appearance. 

User slices and layer-based slices are illustrated by a solid line, and auto 

slices are illustrated by a dotted line. User slices and layer-based slices are 

shown by a distinct icon. You can either show or hide auto slices, and could 

make your workspace easier for you.

A subslice is a type of auto slice that is generated when you create 

overlapping slices. Subslices let you know how the image is divided when 
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you save the optimized file. Although subslices are numbered and shown 

with a slice-like symbol, you cannot choose or edit them individually from 

the underlying slice. Subslices are remade every time you arrange the order 

of slices.
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Slices are created using different methods:

 Auto slices are automatically generated.

 User slices are created with the slice tool.

 Layer-based slices are created with the layers palette.
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Slicing a Web Page

When slicing a web page you use the slice tool to draw slice lines right on an

image. You can also design your graphic using layers, and then create slices 

based on the layers.

Create a Slice with the Slice Tool

1. In your tools palette, select the slice tool. Any existing slices 

automatically appear in the document window.

2. Select a style setting in your options bar:

 Normal - Lets you determine a slice proportion as you drag. 

 Fixed aspect ratio - You set your height-to-width ratio. You will 

enter whole numbers or decimals for the aspect ratio.

 Fixed Size - This specifies your slices height and width. You will 

enter pixel values in as whole numbers. 
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3. You will drag over the spot where you want to create a slice. While 

holding shift, drag to constrain the slice to a square. While holding alt, 

drag to draw from the center. Select view then snap to line up a new 

slice to a guide or another slice in the image.



Create Slices from Guides

1. You will add guides to an image.

2. You will select the slice tool, and select slices from guide options in 

the options bar.

Your existing slices will be deleted once you create a slice from a guide.

Create a Slice from a L

A layer based slice hold together all the pixel data in the layer. Once you 

move the layer or edit the layers content, the slice area will 

the new pixels automatically. Layer
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uides

You will add guides to an image.

You will select the slice tool, and select slices from guide options in 

Your existing slices will be deleted once you create a slice from a guide.

Create a Slice from a Layer

A layer based slice hold together all the pixel data in the layer. Once you 

move the layer or edit the layers content, the slice area will adjusts to include 

the new pixels automatically. Layer-based slices are not as flexible as the 

You will select the slice tool, and select slices from guide options in 

Your existing slices will be deleted once you create a slice from a guide.

A layer based slice hold together all the pixel data in the layer. Once you 

adjusts to include 

based slices are not as flexible as the 
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user slices, but you can convert a layer-based slice to become a user slice. 

Here’s how:

1. Select a layer in the layers palette.

2. Select layer then select new layer based slice.
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Convert Auto and Layer-Based Slices to User Slices

Your layer-based slice is tied to the pixel content of a layer, so the only way 

to combine, divide, move, align, and resize it is to edit the layer. This will 

not work unless you convert it to a user slice. All your auto slices in an 

image that are linked and they share the same optimization settings. When 

and if you want to set different optimization settings for an auto slice, you 

need to change it to a user slice. Here’s how:

1. Using the Slice Select tool, select one or more slices to switch.

2. Select promote in the options bar.
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View slices and slice options

In Photoshop, you can view slices in the save for web and devices box. The 

following characteristics can help you tell the difference between slices:

 Slice lines- They define the limit of the slice. Solid lines indicate that 

the slice is a user slice or layer-based slice and an auto slice is shown 

with dotted lines. 

 Slice colors- You can tell the difference between user slices and 

layer-based slices from auto slices. User slices and layer-based slices 

shown with blue symbols, and auto slices are shown with gray 

symbols by default.

You can also use the save for web and devices box to use color adjustments 

to dim unselected slices. These adjustments are for show only and will not 

affect the color of the final image. Your color adjustment for auto slices is 

twice the amount of that for user slices, by default. 



 Slice numbers-

bottom. They begin in the upper left corner of the image. Even if you 

change the order or total number of slices, the slice numbers are going 

to update to reflect the new order. 

 Slice badges- The following icons show certain conditions like user 

slices have no image content, user slices have no image content, and 

slices are layer based.
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The slices are numbered from left to right and top

bottom. They begin in the upper left corner of the image. Even if you 

change the order or total number of slices, the slice numbers are going 

to update to reflect the new order. 

The following icons show certain conditions like user 

es have no image content, user slices have no image content, and 

slices are layer based.

The slices are numbered from left to right and top to 

bottom. They begin in the upper left corner of the image. Even if you 

change the order or total number of slices, the slice numbers are going 

The following icons show certain conditions like user 

es have no image content, user slices have no image content, and 
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Show or Hide Slice Boundaries

Select view then select show, and then slices. To hide and show slices along 

with other items, use the extras option. To hide or show your slices do the 

follow, you can either select the slice select tool, and click show auto slices 

or select hide auto slices in your options. You can also select view, then 

show, and then select slices. Your auto slices will show with your other 

slices. To show and hide you slice numbers. Select edit, then preferences, 

and then slice and count, guides, and grids. An easier way is to select slices 

and click on show slice numbers. To change your color on your slice lines 

select edit then preferences, and then guides, slices and count, grid. Another 

way is to click slice lines and simply choose a color from the line color 

menu. After you have your color, only select line will be colored.
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Modifying slices

Select One or More Slices

First you will need to select a group or just one slice. Then you will do one 

of the following options. You can select the slice select tool and then click 

the slice in the image. When working with overlapping slices, click the 

section of an underlying slice to select it. You could also try to select the 

slice select tool, and hold down the shift key and click to add slices to the 

selection. Another option is to select the slice select tool in the save for web 

and devices box. Then click in an auto slice or outside the image area, and 

click and drag across the slices you want to select. You can also simply just 

go to file, then save for web and devices. Use the slice tool to select a slice 

in the box.

Move, resize, and snap user slices

You can move and resize user slices in Photoshop, but you can not in the 

save for web and devices box.
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Move or resize a user slice

1. Select one or more user slices.

2. To move a slice, move the pointer inside the slice selection border, 

and drag the slice to a new position. Press and shift to only allow 

movement to a vertical, horizontal, or 45degree diagonal line. When 

you want to resize a slice, grab a side or a corner handle of the slice, 

and drag it. If you select and resize adjacent slices, common edges 

shared by the slices are going to be resized all together.

Resize or move a user slice using numeric coordinates

1. Select more than one or just one of the user slices.

2. Select the options button in the options bar. You can also double-click 

on the slice to show the options.

3. In the dimensions area of the slice options box, and change one or 



more of the following options:

 X- Will specify the distance in pixels between the left edge of the 

slice and the location of the ruler in the document window. 

 Y- Will specify the distance in pixels between the top edge of the slice 

and the location of the ruler in the document window.

 Note: The default origin of the ruler is the upper left corner of the 

image.

 W- This will specify the width of the slice. 
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more of the following options:

Will specify the distance in pixels between the left edge of the 

slice and the location of the ruler in the document window. 

Will specify the distance in pixels between the top edge of the slice 

and the location of the ruler in the document window.

Note: The default origin of the ruler is the upper left corner of the 

This will specify the width of the slice. 

Will specify the distance in pixels between the left edge of the 

slice and the location of the ruler in the document window. 

Will specify the distance in pixels between the top edge of the slice 

Note: The default origin of the ruler is the upper left corner of the 



 H- This will specify the height of the slice.

Snap Slices to a Guide, User Slice, or Other Object

1. Select the options you would like to use from by clicking view then 

snap to submenu.

2. Select view then snap, and a check mark will let you know that the 

option is turned on.

3. Move your selected slices where you want them. 

any of the objects within 4 pixels.

Divide User Slices and Auto S
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s will specify the height of the slice.

Snap Slices to a Guide, User Slice, or Other Object

Select the options you would like to use from by clicking view then 

snap to submenu.

Select view then snap, and a check mark will let you know that the 

turned on.

Move your selected slices where you want them. The slices snap to 

any of the objects within 4 pixels.

Divide User Slices and Auto Slices

Select the options you would like to use from by clicking view then 

Select view then snap, and a check mark will let you know that the 

The slices snap to 
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You can use the divide slice box to divide slices vertically, horizontally, or 

both. When a slice is divided the slices are always user slices, regardless if 

the original is a user slice or an auto slice. To divide your slices:

1. Select one or more slices.

2. With the slice select tool clicked, you will click divide in the options 

bar.

3. Select preview in the divide slice box to preview the changes you 

have made.

4. Then in the divide slice box, you will select one or both of the 

following options, either divide horizontally into which divide the 

slice lengthways, or divide vertically into which slices width-ways.  

5. Figure out how you want to divide each of your selected slices, by 

either selecting and enter a value for slices down or slices across to 

divide each slice evenly into a certain number of slices. You then 

select and enter a value for pixels per slice to create slices with the 

certain number of pixels. If the slice you have selected cannot be 
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divided evenly by that number of pixels, what’s left over is made into 

another slice. For example, if you divide a slice that is 50 pixels wide 

into two new slices each 20 pixels wide, what’s left over will be 

10-pixel-wide area that will  becomes a new slice.

6. Click OK.
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Duplicate Slices

You can make a duplicate slice with the same measurements and 

optimization settings as the original slice. If the original slice is a linked user 

slice, the duplicate is linked to the same set of linked slices. Duplicate slices 

are always user slices, no matter if the original is a user slice, a layer-based 

slice, or an auto slice. To duplicate your slices first select multiple slices or 

just one slice. Then press and hold alt while dragging from inside the 

selection. 

Copy and Paste a Slice

You can copy and paste your selected slice within your first image, and then 

into another image, or into another application like Dreamweaver. Copying a 

slice copies all layers within that slice, not just the active layer. To copy and 

paste your slices follow these steps:

1. Select one or more slices with the slice select tool.

2. Select edit then copy, but a slice can not be copied if the document 
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has an active selection in it.

3. When you want to paste the slice into another image, open and show 

the image. If you are going to be pasting into Dreamweaver, make 

sure your Dreamweaver document is in the active window.

4. Select edit and then select paste. A new layer will be created when a 

slice is pasted into a Photoshop image.
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Combine Slices

You can combine two or more slices and make them a single slice. 

Photoshop will determine the dimensions and position of the ending slice 

from the rectangle that will be created by joining the outer edges of the 

combined slices. If the combined slices are not adjacent or have different 

proportions or alignments, the combined slice that you created may overlap 

other slices. The combined slice that you made takes the optimization 

settings of the first slice in the set of slices you select. A combined slice is 

always a user slice, even if the original slices include auto slices. To 

combine slices, first select a group of slices or just one, and then right-click 

and select combine slices.

Change the Stacking Order of Slices

When your slices overlap each other, the last slice you created is the top 

slice in the stacking order. You can change the stacking order to get to other 

layer slices. You can select which slice you want on the top and which one 

you want on the bottom of the stack and even move slices up or down in the 



stacking order. To change the stacking order first select a single slice or 

select multiple slices. Then you will select the slice sel

will click a stacking order option you want.

Align and Distribute User Slices

You can align user slices along an edge or their centers, and spread 

slices evenly out along the vertical or horizontal axis. By aligning and 

distributing user slices, you can eliminate auto slices that you do not need 

and create a smaller, more efficient html file. To align and distribute user 

slices, you first select the user slice that you want to have aligned, and then 

select the slice select tool, and pick on of the options in the option bar.
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stacking order. To change the stacking order first select a single slice or 

select multiple slices. Then you will select the slice select tool, and then you 

will click a stacking order option you want.

Align and Distribute User Slices

You can align user slices along an edge or their centers, and spread 

slices evenly out along the vertical or horizontal axis. By aligning and 

distributing user slices, you can eliminate auto slices that you do not need 

and create a smaller, more efficient html file. To align and distribute user 

slices, you first select the user slice that you want to have aligned, and then 

t tool, and pick on of the options in the option bar.

stacking order. To change the stacking order first select a single slice or 

ect tool, and then you 

You can align user slices along an edge or their centers, and spread the user

slices evenly out along the vertical or horizontal axis. By aligning and 

distributing user slices, you can eliminate auto slices that you do not need 

and create a smaller, more efficient html file. To align and distribute user 

slices, you first select the user slice that you want to have aligned, and then 

t tool, and pick on of the options in the option bar.
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Delete a Slice

When you want to delete a user slice or layer-based slice, auto slices are 

remade to fill the document area. Deleting a layer-based slice does not delete 

the next layer, but deleting the layer next to the layer-based slice does delete 

the layer-based slice. To delete a slice, you first must select a group or just 

one slice, and then select the slice select tool and press the backspace button 

on your keyboard. Then delete all your user slices and layer-based slices by 

clicking view then selecting clear slices.

Slice Output Options

Display the Slice Options Dialog Box

You are going to open your dialog box to see what you want to change. To 

display your slice options box first double-click the slice you want with the 

slice select tool. While you now have the slice select tool active, you can 

now click on the slice select options.
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Specify a Slice Content Type

You can dictate how the slice data appears in your web browser when you 

export with an html file. The options that are available are different 

according to the slice type you select. When your image slice contains image 

data, this is the default content type. None of the image slices let you create 

empty table cells that can be filled with text or a solid color. You can enter 

html text in a no Image slice. If you set the text to html option in the save for 

web and devices dialog box. Your text will be given off as html when 

viewed in a browser. Slices of an image are not exported, and can only be 

previewed in your browser.  To specify the slice content type first select the 

slice you want to use by double-clicking the slice with the slice selection 

tool to open the slice options. Once open, select a type of slice from the type 

menu in the slice option box.
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Rename a Slice

You will find it helpful to rename your slices while you work on your image. 

Your user slices are named according to the settings in the output options 

dialog box by default. Layer-based slices are given the name of the layer 

from which they come from. You then select a slice and double-click the 



slice with your slice select tool to show the slice options dialog box. In the 

slice options box, you will create and type a new name in the name text 

Choose a Background Color for a Slice

To fill the transparent area or and entire area of your slice, you can select a 

background color. Photoshop does not show the selected background color. 

You must preview the image in a browser to see the 

background color. To choose a background color for your slice you must 

first select a slice and double

open your options box. Now that is open select a background color of your 

liking from the background color menu. You can select from the eyedropper, 

matte, none, white, black, or other.
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slice with your slice select tool to show the slice options dialog box. In the 

slice options box, you will create and type a new name in the name text 

Choose a Background Color for a Slice

To fill the transparent area or and entire area of your slice, you can select a 

background color. Photoshop does not show the selected background color. 

You must preview the image in a browser to see the effect of the selected 

background color. To choose a background color for your slice you must 

first select a slice and double-click the slice with you slice selection tool to 

open your options box. Now that is open select a background color of your 

from the background color menu. You can select from the eyedropper, 

matte, none, white, black, or other.

slice with your slice select tool to show the slice options dialog box. In the 

slice options box, you will create and type a new name in the name text box.

To fill the transparent area or and entire area of your slice, you can select a 

background color. Photoshop does not show the selected background color. 

effect of the selected 

background color. To choose a background color for your slice you must 

click the slice with you slice selection tool to 

open your options box. Now that is open select a background color of your 

from the background color menu. You can select from the eyedropper, 
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Assign URL Link Information to an Image Slice

Assigning a URL to a slice makes the entire slice area a link to the desired 

web page. When someone clicks the link, the web browser goes to the 

specified site and target frame. This option is available only for Image slices. 

To assign a URL link to an image slice you first select a slice and open the 

option box by selecting the slice with the slice selection tool. Next, you enter 

in a URL in the URL text box in the slices options. If you would like, you 

can enter a target frame into the target text box. Your choices are as follows:

 Blank displays the linked file in a new window, and will leave your 

original browser window open. 

 Self displays your linked file in the same frame as your original file. 

 Parent displays your linked file in its own original parent frameset. 

Use this option if the html document contains frames and the current 

frame is a child. The linked file appears in the current parent frame. 

 Top replaces your entire browser window with your linked file, 
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removing all current frames. The name must match a frame name 

previously in the html file for the document. Once someone clicks the 

link, the specified file appears in the new frame.
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Specify Browser Messages and Alt Text

You can control what messages appear in the browser you selected. These 

options are available only for image slices and appear only in exported html 

files. To specify your browser message, first select a slice and open the 

option box with slice selection tool. Next, type the text that you desire. Your 

options are either:

 Message text - changes the default message in the browser’s status 

area for a selected slice or slices. The slices URL is shown by default.

 Alt Tag/Alt - specifies an alt tag for a selected slice or slices. The alt 

text shows in place of the slice image in a browser. It also shows in 

place of the image while the image is downloading and as a tool tip in 

some browsers.

Add HTML Text to a Slice

When you choose no image type of a slice, then you can enter text to be 

shown in the slice area of the web page. This can be plain text or text 

formatted with standard html tags. You also have the chance to select 
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vertical and horizontal alignment options. Photoshop does not show html 

text in the document window and you must use a web browser to preview 

the text. Be sure to preview html text in different browsers, with different 

operating systems, and on different browser settings so that your text is 

shown the way you like on the web. To add html text to a slice you must 

first select a slice and the open the options with the slice selection tool. Next, 

select the no image from the slice type menu in the slice options box. Then 

you will enter the text you want in the text box, and if the text includes html 

formatted tags, select the text is html option. If you do not select this, regular 

text will show up on the web page once you save. Finally, select an option in 

the cell alignment section. Your choices are:

 Default - uses the browser’s default settings for its horizontal 

alignment. 

 Left - will align the text to the left side of your slice area. 

 Center - will align the text to the center of your slice area. 

 Right - will align the text to the right side of your slice area. 
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 Default - will use the browser’s default settings for the slices vertical 

alignment. 

 Top - will align your text to the top of your slice area. 

 Baseline - sets a baseline for the first line of text in cells in the same 

row. Each of the cells in the row must use the baseline option. 

 Middle - will center your text vertically in your slice area. 

 Bottom - will align your text to the bottom of your slice area. 

Slicing is sometimes a complicated task.  Keep this chapter bookmarked so 

that you can use it as a reference until you are familiar with all of the steps 

outlined here.
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Chapter 4: Optimizing Images for 

the Web

An important, often overlooked, stage in creating files for the web is 

optimization.  Users with slower internet connections take longer to load 

larger images.  Optimizing images before uploading them to your website 

will curb this problem and make your pages load much more quickly for all 

of your users.

When you intend to publish your images online, you can utilize Photoshop’s 

built in file compression options.  The save for web option will help you 

choose the best file type and the best compression ratio for your images.  In 

this chapter we will discuss the save for web option and you will learn how 

to compress your images effectively.
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Lossy Compression

Most times, compressing files causes some loss of quality.  Lossy 

compression means that after you decompress the compressed data, you will 

not get the exact same image as

the original. However, this will only be visible at a closer look. Lossy 

compression is suitable for the web because images use smaller amount of 

memory, and can still look nearly identical like the original image.  File 

formats associated with lossy compression include: JPEG, 
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Lossless Compression

Lossless compression means that when you decompress an image, you will 

get exactly the same image as the original. This compression uses greater 

amount of memory, so it may not be good for the internet.  

JPEG Images

JPEG, or Joint Photographic Experts Group, is a file format name.  The 

extension for this format is .jpg.  The compression method is usually lossy 

compression, meaning that some visual quality is lost in the process and 

cannot be restored.  JPEG is good for saving images with millions of colors, 

like photographs, drawings with many shades, and images containing 

gradients.

There are variations on the standard baseline JPEG that are lossless, 

however these are not yet widely supported.
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There are also many medical imaging systems that create and process 12-bit 

JPEG images. The 12-bit JPEG format has been part of the JPEG 

specification for some time, but again, this format is not as widely 

supported.

There is also an interlaced "Progressive JPEG" format.  This format is ideal 

for large images that will be displayed while downloading over a slow 

connection, allowing a reasonable preview after receiving only a portion of 

the data.  When Progressive JPEG format is used, data is compressed in 

multiple passes of progressively higher detail.  However, progressive JPEGs 

are not as widely supported.
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GIF Images

GIF is a file format that stands for Graphics Interchange Format, and was 

first used in 1987.  This format is a bitmap.  Bitmap images are formed from 

a grid made of tiny pixel squares. Data about every pixel is saved.  The GIF 

format uses a palette of up to 256 distinct colors from the 24-bit RGB color 

space. This format also supports animations and allows a separate palette of 

256 colors for each frame. The color limitation makes the GIF format 

unsuitable for reproducing photographs and other images with continuous 

color, but it is used most for more simple images such as graphics or logos 

with solid areas of color.

Photoshop can control the exact number or colors stored in a particular 

image. This makes GIF a good format for saving images with limited colors, 

like charts, small graphics and icons, images containing text and other 

important details, and flat-color drawings.

GIF images are compressed using the Lempel-Ziv-Welch (LZW) lossless 

data compression technique to reduce the file size without compromising the 

visual quality. This compression technique was patented in 1985. A 

controversy arose in 1994 over the licensing agreement between Unisys, the 
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patent holder, and CompuServe.  The issue inspired the development of the 

Portable Network Graphics (PNG) standard.  Since that time, all the relevant 

patents have expired.  The GIF format is still widely used and acceptable for 

many tasks in Photoshop.
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PNG Images

Portable Network Graphics or PNG, is a bitmapped image format that 

employs lossless data compression. PNG was created to improve upon and 

replace the GIF format. This format was created to become the new and 

improved GIF, because GIF was patented, and no longer free. PNG has 

greater color-depth than GIF.  It can also store partial 

Images should be saved in PNG format when transparency needs to be 

preserved, a large amount of colors are present, or the image contains partial 

transparency. PNG is a lossless format and file sizes are often too large for 

displaying on the web.

The PNG format was designed for transferring images on the internet, not 

for professional graphics.  For this reason, the PNG format does not support 

other color spaces.  PNG supports palette-based (palettes of 24-bit RGB

colors), greyscale or RGB images.
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Colorful Images

Saving images that have many colors, such as photographs, can be done 

using the following steps:

 Choose File > Save for web...

 Since the image has many colors, choose PNG or JPEG.

 You can check the option Progressive if you like.  The only difference 

is how the loading will look like. Progressive images first appear 

blurry, and then become clearer as the image loads. Non-progressive 

images load line-by-line.

 First choose quality level, High if the image will be visible, Medium 

or Low if it is to be used as a background.

 To have more control over the quality, use the slider or enter an 

integer in the Quality field.
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 Look at the file size and estimated loading time displayed in the 

lower-left corner while adjusting settings.  At the same time, look at 

the image to decide on what quality looks good enough.

o If you are dealing with a background image, make sure the file 

size is under 5KB, up to 2KB would be better.

o If the image is a layout header, up to 40KB is acceptable.

o If the image is to be displayed on the page, 20-30KB is 

reasonable, depending on dimensions.

o Artworks may be saved in better quality, since people who will 

look at them already expect to see large images.

 Once you have found the perfect balance between quality and 

compression, click the button Save
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Flat Images

 Choose File > Save for web...

 Since the image has a minimal amount of colors, choose GIF.
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 If the image contains transparent pixels, make sure the transparency 

box is checked.

 Select the number of colors.  Try to make the number the smallest you 

can, while ensuring that the image is not being distorted too much.

 If the image is not in the main focus, you can add lossyness by 

dragging the slider to the right. This will reduce the file size.

 Once you have found the perfect balance between quality and size, 

click the save button.

Following these steps and using the information contained in this chapter 

will help you optimize images for the web.  Without optimization, your files 

will take an extended amount of time to load.  With optimization, your files 

may lose some quality, but most times the quality is not an issue when being 

viewed on the web.  Refer back to this chapter and the steps outlined here 

until you are familiar with optimizing your files.
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Chapter 5: Photoshop Settings in 
Dreamweaver

The good thing about working adobe programs is that you can use them 

together. Once you create an image in Photoshop you can insert Photoshop 

image files in PSD format into web pages in Dreamweaver.  Once in 

Dreamweaver, your image will automatically be optimized as web-ready 

images in gif, png, and jpeg formats. You can also paste some or all of your 

multi-layered or multi-sliced Photoshop image into a web page in 

Dreamweaver.

Working with Photoshop and Dreamweaver

When you use Photoshop to create images, you can use Dreamweaver to 

optimize your images for the web and then insert them into web pages. You 

can also choose slices or layers in a Photoshop image, and then you can use 

Dreamweaver to put them as images in web pages. Then after you insert 
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these images in web pages, you will be able to edit the source files in 

Photoshop and the update that same file in Dreamweaver.

You can use your then following steps to insert an image that you made in 

Photoshop into a web page. When you create an image in Photoshop, and 

save your image as a regular Photoshop PSD file, you won’t have to save as 

a jpeg, png, or gif because Dreamweaver will do it for you. Once your image 

is in Dreamweaver, you can select the PSD file and place it into the web 

page. Dreamweaver will allow you to optimize the image for the web, and 

then place it on the page.

You can use the following steps for using a Photoshop layer or slice image 

as a layer or slice image in a web page. When you are in Photoshop you will 

select and copy the slice or layer to your clipboard.

Once your image is in Dreamweaver, you can paste the slice or layer into 

your web page. You can use Dreamweaver to optimize your image for the 

web, and then place it on the page.
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Follow theses steps when you want to update web images that were 

originally made in Photoshop. Once you open in Dreamweaver, you will 

select the gif, png, or jpeg file that you got from a PSD file and inserted with 

Dreamweaver. Then you click the edit image button in your properties panel. 

Dreamweaver will open the original file in Photoshop. Go back into 

Photoshop to make your changes to the original file and save it. Then copy 

all or part of the image to your clipboard. After you have to edited image, 

you will paste it into Dreamweaver over the web image in the page. 

Dreamweaver will optimize the original file using the original optimization 

settings, and then switches the image on the clipboard with the updated 

original image.

Inserting a Photoshop Image into Your Web Page

 In design or code view in Dreamweaver place the insertion point on 

your page where you want the image inserted.

 Click insert then select image.

 Find your PSD image file from Photoshop in the select image source 
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box by clicking the browse button and finding it.

 In your image preview box that shows up, you will adjust the 

optimization settings to your preference and click ok.

 Save your web ready image file to find your website root folder. If 

you save outside your default image folder, you image will save in the 

spot you saved, Dreamweaver will ask you if you want to copy your 

image in your default image folder. It is best to select ok so that your 

image is placed on your Dreamweaver page, and if you do not select 

to copy it will save in the location you put it but will not show up on 

your Dreamweaver page. 

Dreamweaver will set up your image according to the optimization settings 

and places a web-ready version of your image in your Dreamweaver page. 

The information of your image is saved to a design note, such as the location 

of your PSD file and the filename. The design note gives you the ability to 

go back and edit the original image in Photoshop.
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Copying a Photoshop Selection into Your Page

You can copy and paste either all or some of a Photoshop image into your 

Dreamweaver page. You can copy one layer or a group of layers for a 

selected area of the image. You can also copy a slice of the image. To copy a 

Photoshop selection start by copying some or all of a single layer using your 

marquee tool. The select edit to copy. This will only copy the active layer, 

and if your layer has layer-based effects, the effects won’t be copied. You 

can also copy and merge groups of layers using your marquee tool, and then 

select edit to copy merge. This will copy and flatten you active layers and 

the layers under the active layer to your clipboard. You can copy your slices 

using the slice select tool to choose your slice. Once you have done that, 

select edit to copy. This will copy all of your slices, active and lowered, and 

place them in your clipboard. Next, in design or code view in Dreamweaver, 

place the spot on your page where you want your image to go. Then select 

edit to paste. In your image preview box, you can adjust your optimization 

settings and select export. Save your image in your website’s root folder.
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Using Photoshop to Edit Images for Dreamweaver Pages

After you place Photoshop images in your Dreamweaver pages, you can edit 

it in Photoshop. Remember to edit in Photoshop to make changes to your 

image in Dreamweaver.

Editing the Original PSD File in Photoshop

 In Dreamweaver, select the image you made in Photoshop and either 

select the edit button in the images property inspector. You could also 

press and hold control while double-clicking the file, or you can right-

click an image and select edit source with from your menu and then 

select Photoshop.

 After you have edited the file in Photoshop, you could either reinsert 

the file and redo your optimization, or copy and paste your image or 

selection directly into your page to update your images changes.
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Editing png, jpeg, or gif Image Files in Photoshop

 Once your image is in Dreamweaver you will select edit to 

preferences and to file types and select Photoshop as the default editor 

for png, jpeg, and gif file types. It will be set by default as the primary 

editor for your PSD file. When you want to add a new file, just click 

the plus sign in the panel on the left side. To change the external 

editor file type, just select the type you want in the panel on the left 

side and then click the plus button on the right side. This will place 
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you in the select external editor file box.

 Select your image that you first created in Photoshop and either press 

and hold alt while double-clicking a file. Another way is to right click 

the image and select edit with and select browse from your context 

menu, and then locate the Photoshop file. You could simply click 

modify, then image, and then Photoshop.

 After you have finished making your changes in Photoshop, save your 

file.

 Your file will be updated automatically in Dreamweaver, but you 

might have to reset your images size. 
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Reinserting Photoshop Images from Dreamweaver

If you switch out an image made in Photoshop with an image on your 

Dreamweaver page by inserting a different PSD file, your image preview 

box will show up and you will have to reenter your optimization settings. 
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First, when you are in Dreamweaver you will choose a new PSD file by 

either using the point to file icon and select a new PSD file from your file 

panel, or just double-click an image that is already there and browse your 

new files. Next, adjust your optimization settings, and save your file.

Recopying a Photoshop Image Selection

If you switch out an image made in Photoshop with an image on your 

Dreamweaver page with a copied selection from a PSD file, your image 

preview box will not appear. Dreamweaver will reuse the optimization 

settings you set for that image in your page. To do this, go to your image in 

Photoshop and make the changes necessary and copy either all or part of the 

image. Next, go to Dreamweaver and select your existing image. Then 

finally select edit and then paste.

Adobe has done a fine job with making their programs where they can 

function together. Creating your images that you want to go on your website, 

and transferring them over to Dreamweaver makes it easier for you to make 

your website the way you want it. You learned how to insert a Photoshop 

image into your web page, copy a Photoshop selection into your web page, 
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and use Photoshop to edit images for your Dreamweaver page. You also 

gained knowledge on reinserting a Photoshop image in Dreamweaver, and 

recopying a Photoshop selection. Take this new knowledge and make your 

website the way you want it to look. 

This has been The Essentials of Web Layouts in Photoshop.  This is a 

comprehensive reference that can be drawn on whenever you are in the need 

of help with web layouts in Photoshop.  Also, refer to the first two books in 

this series, The Essentials of Drawing in Photoshop and The Essentials of 

Design with Photoshop.

Thanks for reading!

If you have any questions, comments or feedback send me an email to 

kevin@tutorialhell.com
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